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Aims and Learning Objectives 

The aim of this document is to introduce the basics of image processing using Adobe 
Photoshop. 

By the end of this course you will be able to: 

• crop an image; 

• correct perspective problems; 

• adjust the tone and colours of an image; 

• sharpen an image; 

• scale an image; 

• retouch a damaged photograph; 

• save an image in a suitable format; 

• make selections using a variety of tools; 

• blend images to create a seamless montage; 

• add and edit text. 
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Document Information 

Course documents and files 

If you are working in the training room the files you need are in C:\User\Graphics\ 

If you want to work through the practical tasks shown in this document on your own system, obtain 

the necessary files from: 

http://www.bristol.ac.uk/is/info/websupport/resources/photoshop-t1.html  

Related documentation 
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Prerequisites 

This document assumes that you are familiar with the use of a computer keyboard and 
mouse, Microsoft Windows-based products and the use of a Web browser such as Netscape 
or Internet Explorer. 

Introduction 

There is little doubt that the use of digital images in learning, teaching and research projects 
is growing. Typical uses include: supporting lectures and other presentations; creating Web-
based instruction and creating digital image archives. Another advantage of digital images is 
that they can be delivered on a variety of supports: PowerPoint, Web, image database, CD-
ROM and print. It is therefore important to be familiar with image digitisation processes in 
order to obtain images that are ‘fit for purpose’. 

This document shows you how to apply image enhancement techniques using Adobe 
Photoshop CS2. 
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Introduction to Photoshop 

Photoshop is the ultimate Swiss army knife for all your imaging needs, from basic to highly 
sophisticated image editing. For example you can simply enhance a photograph (remove red eye 
effect and scratches, crop, etc.), or create a complex photo collage or a sophisticated Web 
interface. 

 

 

 
 
The main components of the Photoshop work area are: 

• Menu bar - contains menus organised by tasks. For example, the Layers menu contains 
commands for working with layers. 

• Toolbox - contains tools for creating and editing images. 

• Options bar – provides options for the currently active tool. 

• Active image area (also called Document window) – displays the active open file. Several 
images can be open at the same time, but only one can be active at a time. 

• Palettes – help you monitor and modify images. They can be nested by dragging the title tab 
of one into the body of another. Use the Window menu to show/hide palettes 

Other useful elements are: 

• Palette well – helps you organize the palettes in your work area. 

• Status bar – located at the bottom of every document window, it displays useful information 
about the image and brief instructions for using the active tool. 

• Context menu – display commands relevant to the active tool, selection, or palette. You 
access them by right-clicking on an image or palette item. 

The Toolbox, Palettes and Active image area can easily be moved around the workspace by 
clicking the top bar and dragging them. 

Option bar 

Menu bar 

Palette well
Palettes

Toolbox 

Active image area 
Context menuStatus bar 
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The Toolbox 

Crop Tool

Hand Tool

 
 
 
 
 
 

 
 
 
 

 

Set foreground/
background 

color 

Move Tool 

Magic Wand Tool 

 

 

 

 

 

 

 

Zoom Tool 

 

The Photoshop CS2 Toolbox contains all the tools you need for manipulating and creating 
images, for example, making selections, cropping, drawing, painting, erasing, moving, 
magnifying, etc. 

Some of the buttons represent families of tools rather than single tools. For example, the 
Rectangular Marquee Tool is the default for selecting geometrical shapes, but if you right-
click on it, a palette pops out with more choices such as an Elliptical Marquee Tool. 

Further options are available when you hold down the <Shift>, <Ctrl> or <Alt> keys as you 
use a tool. For example, hold down <Shift> to select a circular shape with the Elliptical 
Marquee Tool. 
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Palettes 

Palettes are one of the main means of accessing many of the features of Photoshop. You can 
show and hide them using the Window menu. Alternatively, you can press the <Tab> key while 
holding down <Shift> to hide/show them all. 

Palettes can be moved around or nested (stacked behind one another) by dragging the title tab of 
one palette onto the body of another. 

  
 

 
 

To bring a palette to the front, just click its title tab. 

You can also expand/collapse them by double-clicking on the title tabs. 

If you don’t like having palettes floating 
around, you may prefer accessing them from 
the Palette well. To add a palette to the 
Palette well, simply drag it into it as 
illustrated on the right. 

Clicking on the right pointing arrow  in the 
top right corner will bring out a menu specific 
to the active palette. 

 

Two of the most useful palettes are the Layers palette and the History palette: 

The Layers palette 

Layers are an essential part of Photoshop and you need to think of them as the building blocks to 
every image that you create. Individual palettes and the toolbar can be displayed or hidden using 
the Window menu (those with a tick mark next to them are visible). 

The Layers palette enables you to control elements of an image by assigning separate layers to 
each individual element. Layers allow you to work on one element of an image without disturbing 
the others. 
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The idea is that you stack layers (in the same way that you would stack sheets of acetate 
transparencies) containing the various elements that will form your final image. There are different 
types of layers: 

• Image layers are transparent and may contain images or part of images. They can also be 
used for drawing, filling with colour, etc. They contain pixel information only. 

• Adjustment and fill layers allow you to make colour and tonal adjustments to your image 
without permanently changing its pixel values. 

• Type layers allow you to insert text in your image. A new Type layer is automatically added 
above the active layer when using the Type Tool. 

• Shape layers are filled with solid colours and the outline is defined with a vector mask 
and/or a layer mask. A new Shape layer is automatically added above the active layer when 
using one of the shape tools (Rectangle/Rounded Rectangle/Line/etc Tool). 

In addition, you can manipulate each layer individually by applying various styles and effects 
(blending, drop shadow, etc.), filters and masks. 

The History palette 

Every change that you make to your image is recorded in the History palette as a history state. 

 

Blending modes 

Hide/Show layer 

Link layers Add a layer style 

Add layer mask

Create new fill or 
adjustment layer 

Create a new group 

Create a new layer 

Delete layer

Reveals layer effects

Layer name 

Layer thumbnail 

Layers palette menu

History state slider 

History state 

History palette menu

Create new document 
from current state 

Create new snapshot

Delete current state
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Just click on a state in the History palette to go back to that state (alternatively drag the History 
state slider up or down to point to the state you wish to move to). The states below the one you 
click on are dimmed and will be discarded if you continue to work from the selected state. 

You can also delete states by dragging them into the wastebasket icon in the bottom right corner of 
the palette (alternatively right-click on the name of the state you want to delete, then choose 
Delete from the pop-up menu). Notice that this action will also delete all the subsequent states. 

By default, the History palette will remember 20 states. You can change this by going to 
Edit/Preferences/General. 

Getting help 

Photoshop has a comprehensive help tool (see illustration below). To open it, go to 
Help/Photoshop Help. 

 

Adobe Photoshop Help Center 

 

A-Z Index 



Introduction to digital imaging using Photoshop (photoshop-t1)  

6 

Colour management 

Colour settings 

One problem with imaging software is the issue of screen, scanner and printer inconsistency. For 
example, monitor brightness, contrast and resolution all affect the way an image is displayed. 
Photoshop includes features to help ensure that screen colours will, as far as possible, resemble 
the final image. 

As a rule of thumb, the image mode should be set to RGB Color when working for screen display 
and CMYK Color for printing. To check this, from the main menu, select Image/Mode. 

 

The reason for this is the differing nature of colour creation between media. 

Printers use Cyan, Magenta, Yellow and Black to simulate the full spectrum.  This is known as the 
subtractive method; remove all of these colours and you will end up with white (hence the 
standard paper colour). Adding 100 percent cyan, magenta and yellow would, in theory, result in 
black. However, in practice, results are never perfect, so printers include black ink; this is also a 
more economical way to work. 

Computer screens, along with other digital media such as scanners and digital cameras, replicate 
colour using the additive method.  Red, Green and Blue are combined to create a range of 
millions of colours: Adding 100 percent of each colour results in white light, whereas 0 percent will 
render black, in other words, no light. 

If converting from a screen image to a printed version, all changes should be made in RGB mode 
before a final conversion to CMYK, using the menu shown above. This will remove any colours that 
can only be displayed on screen, replacing them with their nearest printable equivalents. If you 
need to work on an image that has been saved in Indexed Color mode, you will need to convert it 
to RGB Color in order for it to be fully editable. Indexed Color uses a smaller palette to cut down 
on file size. 

The advantage of working in RGB Color is that you have access to all the bells and whistles of 
Photoshop which would otherwise be hidden or greyed out in CMYK Color. 

Choosing an RGB working space 

The colour working space refers to the gamut (range of colours) that can be displayed or printed. 
This range varies for different RGB working spaces and for different devices and can be changed 
in Photoshop. 
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sRGB IEC-61966-2.1 

sRGB is the standard colour space for PC computer monitors and is the colour space assumed by 
many applications (including Web browsers and Photoshop). However, it has a limited gamut, 
sufficient for on-screen use (e.g. Web design, PowerPoint presentations), but unsuitable for quality 
printing, since it clips colours in the CMYK gamut. 

Adobe RGB (1998) 

Adobe RGB (1998) has become the recommended RGB editing space for RGB files that are 
destined to be converted to CMYK for print output. It provides a much wider gamut and 
consequently it has a much better ability to capture very deep or bright colours. 

The figure on the right shows the full colour gamut (billions 
of colours) visible to the human eye. A shows the typical 
Adobe RGB (1998) colour space and B the sRGB colour 
space. 

As you can see, A covers a greater range of colours than 
B. 

There are other RGB colour spaces that have a much 
wider gamut (Wide Gamut RGB), however, these are 
intended for highly specialised applications. 

To summarise, you should stick to sRGB for images 
intended to be used on the Web or for on-screen 
presentations, and convert to Adobe RGB (1998) for 
images intended for print (after conversion to CMYK) 

 

Chromatic 
diagram 

• To change the RGB colour space from sRGB to Adobe RGB, go to Edit/Color Settings. In the 
Color Settings dialogue box, in the RGB drop-down menu (under Working Spaces) select 
Adobe RGB (1998) as shown below: 

 

• To convert from RGB mode to CMYK, go to Image/Mode and select CMYK Color from the 
list. 



Introduction to digital imaging using Photoshop (photoshop-t1)  

8 

Monitor calibration 

The Adobe Gamma utility comes bundled with Photoshop and can be used to calibrate a monitor’s 
settings: RGB colour balance, brightness, contrast and white point (the point at which colour will be 
displayed as white). 

To launch the Adobe Gamma wizard, go to Settings/Control Panel and double-click on the icon 
labelled Adobe Gamma. 

The wizard will appear as follows: 

 

Make sure the Step By Step (Wizard) radio button is checked and click the Next button to 
proceed. 

Leave the default monitor profile selected unless you know of a better match for your screen, in 
which case click the load button and choose from the list displayed. 

Click the Next button and follow the on-screen instructions to set the brightness and contrast of 
the monitor. 

Again, click Next to display the Phosphors pop-up.  This should be left unchanged, unless you 
know for certain that your monitor’s phosphors differ from the default option. 

Proceed by clicking the Next button. Uncheck the View Single Gamma Only box and set the 
gamma (mid-tone) brightness of your screen for each primary colour by following the on-screen 
instructions. 
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Assuming you are using a PC, from the dropdown menu, select Windows Default. There is also a 
Macintosh option. The Custom setting is only available to Macintosh users. 

Having clicked Next to continue, leave the Hardware White Point as displayed unless you know it 
is incorrect. Continue to the next screen, leave Adjusted White Point as set and proceed to the 
final screen.  You have an option to view the screen with before and after settings, before clicking 
the Finish button to name and store your monitor’s new profile. 

See Ian Lyons’ article, Photoshop CS - Colour Management (www.computer-
darkroom.com/ps8_colour/ps8_1.htm) for a more detailed introduction to colour management. 
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Task 1 Getting started 

Objectives To open an image and learn to use some basic tools and menus. 

Comments Cropping consists of selecting the area of an image that you want to keep and 
eliminating what is deemed superfluous. It is probably the first thing you will want to 
do to a photograph. 

 

1.1 Start Photoshop and open an image: 

 Go to Start/Programs/Web Graphics/Photoshop CS2/Adobe Photoshop CS2. 

 Click No to the question ‘Do you want to customize your color management 
settings now?’. 

 Go to File / Open and in C:\User\Graphics\, open the file: egypt150.tif. 

Note     This image was scanned at a resolution of 150 dpi (dots per inch) at 100% of its 
original size. 

1.2 Make a copy of the image: 

 Go to Image / Duplicate. 

 Accept the suggested file name (egypt150 copy) and click on OK. 

 Close the original image by clicking the Close icon in the top right corner of 
the Image Window. 

Note     It is good practice to work on a copy rather than on the original version of a 
photograph, so that you have a backup in case something goes wrong! 

The View menu 

1.3 The View menu contains various utilities that make working with Photoshop easier: 

 Go to the View menu and select the following options (selected options have a tick 
mark next to them): 

• Rulers (it may already be selected) – to display rulers along the top and left 
edge of the Document Window. 

• Show / Grid – to display a grid on the image (grids are useful for aligning 
elements). 
To alter the grid spacing go to Edit / Preferences / Guides, Grids & Slices. 

• Show / Guides – guides can then be positioned anywhere in the image area 
and used for the precise positioning and alignment of image elements 

Note     You can switch grids and guides on and off by (de)selecting Extras in the View 
menu, or using the keyboard shortcut <Ctrl> + H. 

1.4 The ‘Snap to’ feature is particularly useful for precise aligning or positioning of image 
elements (eg text, cropping marquee, etc): 

 Go to View / Snap to to specify the elements (eg Guides, Grid, Document 
bounds, etc) to which you want to snap when snapping is enabled. 

Note     However, sometimes snapping prevents you from correctly placing elements, so it is 
important to be able to switch it on and off quickly. Use the keyboard shortcut <Ctrl> 
+ <Shift> + ; to enable or disable snapping – alternatively go to View / Snap. 
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The Document window 

1.5 Change the ruler unit: 

 Right-click anywhere on the left or top ruler to open the context menu and select a 
different unit than the one selected – settle for Pixels in the end (Figure 1). 

 

Figure 1 - changing the ruler unit 

1.6 Insert guides: 

 Click and hold anywhere in the top ruler, and drag down the mouse cursor until you 
see a horizontal blue line. 

 Similarly, add a vertical guide starting in the left ruler and dragging to the right. 

 To reposition a guide select the Move Tool in the Toolbox, then grab a guide and 
move it up or down, or left or right. 

Note     To enable or disable guides quickly use the keyboard shortcut <Ctrl> + ;. 

 

Figure 2 - scaled preview in the Status bar 

1.7 The Status bar at the bottom of the Document window provides useful 
information: 

 Click anywhere in the status information box containing size / dimension etc 
information, and keep the mouse button down. 

 This will bring up a scaled preview showing the size and position the image will be 
printed at with the current page setup (Figure 2). 

Note     To check or change the page setup, go to File / Page Setup. The default page 
setup should be A4 portrait. 

 Try the same thing but this time pressing the <Alt> key as you left-click in the status 
information box. This will display the image dimensions, the colour mode and 
resolution (Figure 3). 

Right-click
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Figure 3 - image information in the Status bar 

 Finally, click on the arrow next to the status information box (Figure 4), select Show 
and try the different options: 

 

Figure 4 - accessing the status information options 

• Version Cue: a tool for working collaboratively on projects – not relevant to 
most users. 

• Document Sizes: the first figure shows the file size of a flattened version of the 
image. The second, the size if saved with all the layers. 

• Document Profile: the current profile (colour mode and pixel bit depth) 
assigned to the image. 

• Document Dimensions: the image dimensions expressed in the unit set for the 
rulers. 

• Scratch Sizes: the first figure displays the amount of RAM memory used. The 
second shows the total RAM available to Photoshop. 

• Efficiency: summarises how efficiently Photoshop is working. 

• Timing: shows the time it took to complete the last operation. Reset every time 
you change tools or execute a new operation. 

• Current Tool: displays the name of the tool currently selected. 

• 32-bit exposure: Option for adjusting the preview image for viewing 32-bits-per-

channel high dynamic range (HDR) images – not relevant to most users. 

Zooming in and out of an image 

1.8 Using the Zoom Tool: 

 In the Toolbox select the Zoom Tool.  As you hover the mouse pointer 
over the image notice how it changes into a magnifying glass icon with a + 
sign inside. 

 To zoom in: 

• either click on the image repeatedly until you reach the desired level of 
magnification (up to 1600%), 

• or drag the magnifying glass to delimit the area you wish to magnify. 

 To zoom out, hold down the <Alt> key – notice how the plus sign in the 
magnification glass icon changes to minus – and click on the image until you reach 
the desired level of magnification (down to 0.4%). 

 

Status information options 
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Task 2 Cropping and correcting perspective problems 

Objectives To crop an image and straighten out keystone distortion. 

Comments Cropping consists of selecting the area of an image that you want to keep and 
eliminating the outer crop area. The Photoshop crop tool also allows you to correct 
perspective problems (keystone distortion) such as the vanishing vertical edges of a 
building photographed from ground level. 

 

Simple cropping operation 

2.1 Define the crop area: 

 In the Toolbox select the Crop Tool. 

 Click in the top left corner of the area you want to select and drag towards the 
bottom right to mark out the area that you want to keep (crop marquee). Notice how 
the area outside the crop selection dims. 

 Adjust the crop marquee to cover an area similar to that in Figure 5: 

• To scale the crop marquee grab and drag one of the handles – to constrain the 
proportions, hold down <Shift> as you drag a corner handle. 

• To reposition the crop marquee, place the cursor inside the marquee – it will 
change to a black arrow – and drag. 

 

Figure 5 - the crop marquee in the image window 

Note     You can also rotate the crop marquee. Place the cursor just outside one of the 
corners until it changes into a curved arrow, then click and drag. To move the centre 
point around which the crop marquee is rotated, click and drag the centre point 
around which the marquee rotates. 

 

Crop Tool handles Crop Tool handles Crop Tool handles 
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2.2 Commit the crop: 

 When you are satisfied with the position and size of the crop marquee, click 
the Commit button, press <Enter>, double-click in the crop marquee, or 
right-click and choose Crop from the context menu. 

Note     Until the cropping operation has been either committed or cancelled, no other 
tool or menu can be used. To cancel the cropping operation, press <Esc> or 
click the Cancel button in the Options bar.  

Cropping with perspective correction 

2.3 Define a new crop area: 

 Undo your previous crop – either use Edit / Undo Crop, or the History palette. 

 Define another crop marquee, this time making sure you include the vertical lines on 
either side of the characters, as well as the horizontal line below their feet, as shown 
in Figure 7. 

2.4 Correct the keystone distortion: 

 In the Options bar that appears at the top of the screen when you choose the Crop 
Tool, tick the Perspective box (Figure 6). 

 

Figure 6 - the crop tool option bar 

 Click the top left corner handle and drag it to the right until the left marquee border is 
parallel to the vertical line in the image. 

 

Figure 7 - correcting perspective 

 Repeat, using the other corner handles to level the bottom and top horizontal 
marquee borders with the horizontal lines in the image, and the right marquee 
border with the right side vertical line in the image. 

 Once you are satisfied with your selection, commit the crop. 

Perspective tick box 

Vertical line in the image

Crop marquee line 
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Your image should now have perfect vertical and horizontal lines, as illustrated in 
Figure 8: 

 

Figure 8 - cropped image after perspective correction 

Note     This operation can be fiddly, particularly with images that do not have clear vertical 
and horizontal lines. Trial and error and a little patience should overcome any 
difficulty! 

Saving the cropped image 

2.5 To save your image: 

 Go to File / Save As. 

 In the Save In box of the Save As window, go to C:\User\Graphics\, in the File 
Name box replace the suggested file name with egypt_mural_before, and in the 
Format box select TIFF(*.TIF). 

 Click on Save. 

 In the TIFF Options pop-up window, leave the options as they are and click on OK. 
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Task 3 Adjusting overall tone and colour 

Objectives To make basic image corrections using Photoshop’s image correction tools. 

Comments Once you have cropped your image, the next thing you will want to do is improve its 
appearance. For example it may lack contrast, have a colour cast, be too bright, or 
display any combination of these faults. 

 

3.1 Make a duplicate of your egypt_mural_before.tif image: 

 Choose Image / Duplicate and rename the copy as egypt_mural_after. 

 Close egypt_mural_before.tif. 

Note     Having a ‘before’ and ‘after’ image will enable you to compare your modified image 
to the original later. 

Interpreting an image 

3.2 Before making any adjustment, it is important to be able to analyse the image you 
are working on. 

We can use our eyes to make subjective judgements about how the picture looks, 
but for more useful and objective information we can also use the image histogram.  

 In the Window menu, select Histogram. Then open the palette menu and select 
Expanded View (see Figure 9 below): 

 

Figure 9 - expanding the view of the Histogram palette 

The Expanded View displays some extra options (Figure 10): 

 

Figure 10 - the Histogram palette Expanded View 
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palette menu 
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 The histogram shows the shades of tones (pixels) that make up an image as well as 
their distribution for all 3 channels at once (RGB) or individual channels. 

 What does the information provided by the Histogram palette tell you about the 
current image? 

 

 

 

 

 

Adjusting brightness and contrast with Levels 

Note     Open the Layers palette if it is not already open.  Go to the Window menu and 
select Layers. 

3.3 Resetting the input shadow and highlight levels: 

 At the bottom of the Layers palette, click on the Create new fill or 
adjustment layer icon and select Levels to open the Levels dialogue box 
(Figure 11): 

 

 

Figure 11 - the levels dialogue box 

Input Levels 

• The Input Levels’ sliders and entry boxes allow you to increase the contrast by 
adjusting the input shadows and highlights. 

• The Gamma and entry box allow you to adjust the relative image brightness 
between the shadows and highlights (drag the slider left to lighten and right to 
darken the image). 

Channel selector 

Input highlight 
levels slider 

Gamma slider

Input shadow 
levels slider 

Output highlight 
levels slider 

Output shadow 
levels slider 
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Output Levels 

The Output Levels’ sliders allow you to reduce the tonal range (contrast) in an 
image. It is best not to touch these because they inevitably result in loss of data in 
the shadows and highlights – unless you deliberately want to reduce the output 
contrast. 

The histogram in Figure 11 shows that the image has limited contrast, in other 
words we have no dark blacks or bright whites. So the first adjustment we are going 
to make is to reset the darkest shadow and lightest highlight points for each of the 
RGB colour channels: 

 Make sure the Preview box in the bottom right is checked so you can see the 
changes taking place. 

 In the dropdown Channel selector, select Red. 

 Holding down the <Alt> key, first drag the Shadows input slider to the right and set 
it just before you see some shadow detail in the image. Then drag the Highlights 
input slider to the left and set it just before you see some highlight detail. 

 Repeat the previous step for the Green and Blue channels and click OK once you 
are satisfied. 

 Notice how these changes have affected the RGB histogram in the Histogram 
palette (Figure 12): 

 

Figure 12 - image histogram after Levels changes 

 You should now have a better spread of pixel levels between shadows and 
highlights, but notice how some information has been lost at some levels (hence the 
comb-like effect). 

Adjusting the colour balance with Levels 

In the previous task, we used the composite RGB channel of the Levels 
adjustments to correct the overall contrast of the image. We are now going to use 
the same tool to correct colour casts. 

 Re-open the Levels adjustment layer you created in the previous task by double-
clicking on its thumbnail in the Layers palette (Figure 13): 
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Figure 13 - re-open the Levels layer 

At this point you need to decide whether your image has a colour cast and if yes 
which colour. So let’s say your picture looks too blue and you want to add more 
yellow: 

 Go to the Channel menu and select the Blue channel. 

 Move the Gamma slider slightly to the right as in Figure 14: 

 

Figure 14 - correcting a blue cast using Levels 

If your image has a different colour cast, use the following table to decide which 
channel to use: 

Colour cast: Use the colour 
channel: 

Move the 
Gamma slider: 

Colour 
added: 

Red Red Right Cyan 

Green Green Right Magenta 

Blue Blue Right Yellow 

Cyan Red Left Red 

Magenta Green Left Green 

Yellow Blue Left Blue 

Double-click on the 
Levels layer thumbnail 
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Note     When dealing with black and white photographs, you don’t need to adjust each 
colour channel separately. To correct the overall contrast and brightness you can 
use the composite RGB channel instead. Use the Input Levels to improve the 
overall contrast, and then the Input Gamma to correct the brightness. 

More colour adjustments with Hue/Saturation 

3.4 The Hue/Saturation dialogue box allows you to adjust the hue (colour), saturation 
(colour intensity), and lightness of the entire image or of individual colour 
components in an image. 

 Click on the Create new fill or adjustment layer icon at the bottom of the 
Layers palette and select Hue / Saturation to open the corresponding 
dialogue box (Figure 15): 

 

Figure 15 - the Hue/Saturation dialogue box 

The two colour spectrum ramps at the bottom of the Hue/Saturation dialogue box 
provide a visual clue as to how the colours are being mapped from one colour to 
another. 

The Edit dropdown menu at the top defaults to Master, which means any 
adjustment will affect all the colours in an image. The other six options (eg Reds, 
Greens, Blues, Cyans, etc.) allow you to narrow the Hue/Saturation adjustments 
to predefined colour ranges. You can also redefine these ranges using the 
eyedroppers or markers between the colour ramps. 

 In the Edit dropdown menu box, select Reds to start with. 

 Adjust the Hue, Saturation and Lightness by dragging the sliders left or right or by 
entering a value in the corresponding box (-180 to +180 for Hue and –100 to +100 

for Saturation and Lightness). 

 Repeat with other colours – notice that some may have little effect, which indicates 
that these colour ranges are not present in the image. 

 Click OK once you are satisfied with the results. 

Original input 
colour ramp 

Output colour 
ramp 

Eyedroppers

Edit dropdown 
options 



Introduction to digital imaging using Photoshop (photoshop-t1)  

21 

Task 4 Sharpening an image 

Objectives To sharpen an image. 

Comments Photoshop provides four sharpening filters – Sharpen, Sharpen More, Sharpen 
Edges and Unsharp Mask. Unsharp Mask is the one that gives you the most 
control. 

 

 The Unsharp Mask works by increasing the contrast between pixels. Unlike tone 
and colour adjustments, Unsharp Mask is applied to the Background layer (or 
even better a copy of the Background layer), that is the layer containing the original 
image. 

4.1 Create a copy of the Background layer: 

 In the Layers palette, drag the Background layer onto the Create a new 
layer icon to make a copy of it. It will appear as a new layer as shown in 
Figure 16: 

   

Figure 16 - creating a copy of the Background layer 

Creating a copy of your background image protects the original image because it is 
easier to delete a layer rather than undo changes to the background image. 

4.2 Sharpen the image: 

 Make sure the Background copy layer is selected. 

 In the Photoshop Filter menu, choose Sharpen / Unsharp Mask. 

In the Unsharp Mask dialogue box (Figure 17) you can set three parameters: 

• Amount controls the amount of sharpening applied to the edges (1% to 500%). 
Values up to 50% produce subtle effect; values between 50% and 250% produce 
moderate effects. 

• Radius controls the depth of pixel along the high-contrast edges that are 
changed. Values of up to 2.0 produce acceptable sharpening. 

• Threshold sets a level for the minimum amount of contrast between pixels that 
an area must have before it will be modified. Use a low value to apply the filter 
more generally throughout the image. 
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Figure 17 - the Unsharp Mask dialogue box 

 Experiment with the different settings described above and observe the changes to 
the image. 

As a general rule, apply an amount of between 100% and 200%, a radius of 
between 1.0 and 2.0, and a threshold of between 0 and 10. 

Note     Sharpening for output should be applied at the end of a Photoshop session and after 
the image has been resized to the final print size. 

4.3 Save a copy of your image in the Photoshop format. 

 Go to File / Save As. 

 In the Save In box of the Save As window, go to C:\User\Graphics\.  In the File 
Name box replace the suggested file name with egypt_mural_after, and in the 
Format box select Photoshop(*.PSD,*.PDD). 

 Click on Save. 

Note     The reason for saving in the Photoshop format is that it will preserve all the layers, 
which will allow you to make further changes to them at a later stage. 

4.4 Make a copy of egypt_mural_after.psd: 

 Choose the Image / Duplicate command and accept the suggested name 
egypt_mural_after copy. 

 Close egypt_mural_after.psd. 

4.5 You are now going to ‘flatten’ the image (that is, merge the layers) and save this 
new file as a TIFF image. 

 Click on the black pointed arrow in the top right hand corner of the Layers palette 
and click on Flatten Image in the pop-up box (Figure 18): 
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Figure 18 - flattening an image 

Note     You could also use Flatten Image in the Layers menu. 

 Go to File / Save As. 

 In the Save In box of the Save As window, go to C:\User\Graphics\.  In the File 
Name box replace the suggested file name with egypt_mural_after, and in the 
Format box select TIFF(*.TIF). 

 Click on Save. 

 In the TIFF Options pop-up window, make sure IBM PC is selected and that LZW 
Compression is unchecked. 

 Click on OK. 

Click here to open the 
Layers palette popup 
menu. 
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Task 5 Resampling an image 

Objectives To resize and/or resample an image. 

Comments There are times when you will want to modify the size of an image. When preparing 
an image for screen display, you do this by resampling – or interpolating – the 
image. 

 

5.1 Make a copy of egypt_mural_after.tif: 

 Open egypt_mural_after.tif (it may already be opened). 

 Make a copy of it using the Image/Duplicate command and give it the name 
resample. 

5.2 Set the rulers: 

 In the View menu, select Rulers. 

 Next, right-click anywhere on the ruler and select Pixels. 

5.3 Prepare to resample the image: 

 Go to Images / Image Size to open the Image Size dialogue box (Figure 19). 

 

Figure 19 - the image size dialogue box 

 Select Resample Image at the bottom if it is not already selected. 

Note     When Resample Image is selected, the Pixel Dimensions box, at the top, 
becomes active. This allows you to change the pixel dimension of the image. 

 Check that Constrain Proportions is also selected 

Resampling up 

Interpolating up is a process that consists of adding new information (pixels) to an 
image in order to increase its dimensions or resolution, or both. The file size 
increases as a consequence. This process is useful in cases where you cannot 
rescan the original at the correct settings. 



Introduction to digital imaging using Photoshop (photoshop-t1)  

25 

5.4 Increasing the Pixel Dimensions of the image: 

 Select Bicubic Smoother as the interpolation method from the drop-down list next 
to the Resample Image check box. 

Note     Bicubic Smoother is the ideal choice when making the image bigger. 

 If you want to increase the physical dimensions of the image without changing the 
resolution, enter a higher value (for example 800) in the Pixel Dimensions Width 
box. 

Observe the changes in the Document Size options: the Width and Height have 
increased, but the Resolution is unchanged. 

 Click OK and look at your resampled image. 

 Undo the changes that you have just made (Hint: use Edit / Undo Image Size). 

5.5 Increasing the image Resolution: 

 Return to Image / Image Size. 

 If you want to increase the image resolution without changing its physical 
dimensions, enter a higher value in the Resolution box (for example 300). 

Observe the changes in the Pixel Dimensions options: the Width and Height have 
increased accordingly. 

Note     There is a simple rule to help you calculate the relationship between pixel 
dimension, resolution and physical dimension: 
pixel dimension = physical dimension (inches/centimetres) x resolution (points per 
inch/centimetre). 

 Click on OK and look at your resampled image. 

 Undo the changes that you have just made. 

Warning!     Resampling up is a compromise solution since all you do is add pixels to the image 
without increasing the quality and detail. You may need to use the Unsharp Mask 
filter to compensate for blurring, which may occur due to the interpolation process. 
You will obtain better results if you can rescan the image at the right size and 
resolution for its intended use. 

Resampling down 

Interpolating down consists of discarding pixels and results in a smaller file size. 
There are two ways of achieving this: either by decreasing the resolution or by 
decreasing the dimensions of the image. 

5.6 The procedures are the same as for resampling up: 

• If you want to reduce the file size and the total number of pixels while retaining 
the physical dimensions, enter a lower value in the Resolution box. 

• If you want to reduce the physical dimensions while keeping the same 
resolution, enter a lower value in either the Document Size Width or Height 
entry box. 

Interpolating down is particularly useful when you want to create a thumbnail image 
for a Web page. 

Note     A thumbnail is a small image that downloads quickly and can link to another page 
containing the full size image. The advantage of using thumbnails for large images 
is that users of your site can decide whether to view the larger images (and 
therefore wait for them to download) or not. 
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 Open the Image Size dialogue box again, make sure the Resample Image check 
box is selected and select Bicubic Sharper from the dropdown list. 

Note     With Bicubic Sharper, the scaled down image will retain more detail and sharpness. 

 Set the Pixel Dimensions Width to 150 and observe the changes to the Document 
Size dimensions. Click on OK. 

5.7 Save the thumbnail image: 

 Go to File / Save As. Enter egypt_mural_thumbnail in the File name box and 
choose JPEG (*.JPG; *.JPE) in the Format box. Make sure you are saving in 
C:\User\Graphics\, and click on Save. 

 In the JPEG Options dialogue box (Figure 20), move the Quality slider in Image 
Options from small file to large file (alternatively you could use the entry box or 
the dropdown menu). 

 

Figure 20 - JPEG saving options 

 Under Format Options, select Baseline ("Standard"). 

Note     Baseline ("Standard") is the most universally understood JPEG format. 
Baseline Optimised will often produce a slightly more compressed sized file, but 
some web browsers may not be able to read it correctly. 
Progressive creates a file that will download in an interlaced fashion – the image 
downloads in a series of passes and appears blurry at first, until it gradually comes 
into focus. 

Notice the changes in the Size box at the bottom, it tells you how long your file will 
take to download at different connection speeds – select 56.6Kbps, which is the 
most common telephone modem connection speed. 

 Settle for a high quality (for example 10) image and click on OK. 

Note     JPEG is a compressed format widely used for Web images. We cover image 
formats in more detail in Task 6. 
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Checking the print size of an image 

You can also use the Image Size dialogue box to check the print size of an image at 
different resolutions without resampling it. 

 Reopen egypt_mural_after.tif if you closed it and go to Image / Image Size. 

 In the Image Size dialogue box, uncheck the Resample Image option – the Pixel 
Dimensions options will grey out and become un-editable (Figure 21): 

 

Figure 21 - Image Size dialogue box with Resample Image option off 

 Change the Resolution (for example try 225 and 300 pixels/inch) to see the 
changes to the Document Size Width and Height. This is useful so that you can 
check the size of a print out of your image at different resolutions. 

 Go to File / Print with Preview to get an idea of the print size in relation to an A4 
sheet of paper. 

Note     If you find image sizing confusing, use the Resize Image Assistant wizard located 
in the Help menu to guide you. It can be used to resize images both for print and for 
the web. 
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Task 6 Optimising an image to a suitable format 

Objectives To save an image in a suitable format for its intended purpose. 

Comments There are many image/graphic file formats to choose from. However, you don’t need 
to know them all. On this course you have used three different formats so far (TIFF, 
Photoshop and JPEG). We will introduce a fourth one, GIF, which is a popular 

format for screen display. 

 

Let’s start with a brief summary of the four common file formats used on this course: 

• TIFF: The most common cross-platform format for images. TIFF is the format of 
choice for scanned images and archival purposes because it keeps all image 
data intact. The downside is the large file size that makes it unsuitable for the 
Web. 

• PSD: PSD is Photoshop’s own file format. For flexibility in what you can do with 
the file in the future (all layers are preserved), it’s a good idea to save a working 
copy of your image in this format. 

• JPEG: This is one of two standard compression formats used for preparing 
images for the Web (the other one being GIF). It offers a smaller file size than 
TIFF and is the format of choice to compress photographic images for the Web. 

• GIF: This is the other image file format used for preparing images for the Web. It 
is mostly used for saving logos, typography, etc. It is an 8-bit colour display mode 
that indexes specific colours to each of the 256 (or fewer) numeric values. 

6.1 Open your egypt_mural_after.tif again if it’s not already open. 

 Go to File / Save for Web to open the Save For Web dialogue box (Figure 22) and 
click on the 4-Up tab in the top left corner if necessary. 

 

Figure 22 - the save for web dialogue box 

4-Up 
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Saving as a GIF 

 In the 4-Up view, select one of the preview images and set the format to GIF (Figure 
23) 

 

Figure 23 - saving options for GIF format 

 Try out the various options (Lossy, Colors, Dither, etc.) and observe the 
changes to the GIF preview image – it may help if you zoom in using the 
Zoom Tool in the top left. 

Notice the changes to the file size at the bottom of the selected preview image as 
you change the settings. 

Saving as a JPEG 

 Select the top right image and select JPEG from the format dropdown box (Figure 
24): 

 

Figure 24 - saving options for JPEG format 

 Then set the quality to Maximum (100). 

File format dropdown 

Preset file format 
dropdown 

Quality setting 
dropdown 

Quality setting slider

Preset file format 
dropdown 

Colour reduction 
algorithm 

Dither algorithm 

File format dropdown 
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 Select the bottom left image, then select JPEG as format and set the quality to High 
(60). 

 Repeat for the bottom right image, setting the quality to Low (10). 

Notice that the more compressed the image is, the lower the quality, file size and 
download time: 

Format File size Download time 
TIFF 794K N/A 

JPEG Maximum quality 336.5K 62s @ 56.6Kps 
JPEG High quality 81.47K 16s @ 56.6Kps 
JPEG Low quality 22.41K 5s @56.6Kps 

 Use the Zoom Tool in the top left corner to magnify the four images and compare 
the differences in quality.  

You can probably see that there is not that much difference in quality between the 
original image, the JPEG 100 quality and the JPEG 60 quality. For this reason, if 
file size and download time are important criteria then the JPEG 60 quality would 
be a good option. If quality were the most important criterion, then you would 
optimise your image at Maximum quality. 
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Task 7 Retouching a damaged photograph 

Objectives To remove scratches and dust spots from an image. 

Comments Old or neglected photographs often suffer from a variety of defects (scratches, dust 
spots, creases, etc) that devalue them. Photoshop provides a range of tools to 
correct these defects and with a little bit of practice it is easy to repair damaged 
images. 

 

7.1 Open a new image: 

 Go to File / Open and in C:\User\Graphics\, open the file old_image_before.jpg 
and make a copy of it using the Image / Duplicate command. 

 Replace the suggested name with old_image_after and close 
old_image_before.jpg. 

Applying the Dust & Scratches filter to the whole image 

7.2 Create a copy of the Background layer as described in task 4.1 (p. 22): 

You should now have a Background copy layer above your original Background 
layer. 

7.3 Remove dust and scratches: 

 Make sure the newly created Background copy layer is selected in the Layers 
palette. 

 Go to Filter / Noise / Dust & Scratches to open the Dust & Scratches dialogue 
box (Figure 25): 

 

Figure 25 - the Dust & Scratches dialogue box 

 Make sure the Radius and Threshold sliders are all the way to the left to start with. 
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 Slowly move the Radius slider to the right and observe the changes: the spots 
disappear, but the image loses its inherent noise or film grain. Settle for a value of 6 
pixels. 

 Now move the Threshold slider to the right until the spots begin to reappear. Settle 
for a value of around 25 levels and click on OK. 

Note     The degree of success you have with the Dust & Scratches filter depends largely 
on the image or selection to which you apply it. 

Applying the Dust & Scratches filter selectively 

7.4 Although the spots and scratches are mostly gone and the grain restored, you will 
probably notice that some of the important detail has been eliminated. This is 
because the Dust & Scratches filter can’t tell the difference between a scratch and 
an eyelash! 

To remedy this problem, we’ll use a Layer Mask to hide the filtered image and then 
'burn holes' in it to apply the filter only to the damaged areas of the image. 

 Go to Layer / Layer Mask / Hide All. You should see a new, black-filled Layer 
Mask in the Layers palette (Figure 26): 

 

Figure 26 - new layer mask in the Layers palette 

 Make sure the Layer Mask thumbnail is active (it should be framed within a double-
line border); click on it if it’s not. 

 Make sure foreground colour is set to white in the Set foreground/ 
background color tools located in the Toolbox (use the double arrow in 
the top right corner to inverse foreground and background, if necessary). 

 In the Toolbox, choose the Brush Tool and in the Options bar at the top 
of the screen, set Opacity and Flow to 100% (Figure 27). 

 

Figure 27 - the Brush Tool option bar 

 Click the triangle next to the Brush Preset picker and choose a soft-edged brush 
tip about the size of the specks you need to hide (about 17 px). 

 Dab with the Brush Tool where you see specks in the image. 

Notice the changes on the Layer Mask thumbnail in the Layers palette. 

Note     The dabs are like burning little white holes in the mask, allowing the filtered image to 
cover the spots in those areas. 

Layer mask thumbnail 

Brush Preset picker 
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Using the Clone Tool to correct the remaining blemishes 

7.5 Next you will add a “repairs” layer above the filtered layer, where you can make your 
“hand-painted” alterations. This protects the image from painting mistakes and also 
makes it easy to make changes to your repairs later if you need to. 

 Add another layer by clicking on the Create a new layer icon at the bottom 
of the Layers palette. 

 Choose the Clone Stamp Tool in the Toolbox, and in the Options bar set 
the Opacity low (for example 30%) and select the Sample All Layers 
check box (Figure 28).  

 

Figure 28 - the Clone Stamp Tool options bar 

 Click the triangle next to the Brush Preset picker and choose a soft-edge brush tip 
(for example, 17 px) about the size of the specks you need to hide. 

 To start the repairs, hold down the <Alt> key and click in an area near the flaw you 
want the repair to sample from. Release the <Alt> key and move the cursor over to 
the point where you want to clone to and click, several times if necessary, to cover 
the flaw. 

Note     The Clone Stamp Tool works by sampling colours in an area and copying (cloning) 
them to a damaged area. This is a fiddly job which requires frequent sampling, but 
which can ultimately give excellent results. 

Adjusting contrast and sharpening 

7.6 Finally, you could refine your image by adjusting tone, colours and sharpening using 
the methods described in Tasks 3 and 4. 

For this task, we are simply going to apply a “quick fix” to adjust the image contrast. 

 Click the Create new adjustment layer icon at the bottom of the Layers 
palette and choose Levels. 

 Click on Auto and then click on OK. 

7.7 Save your image: 

 Go to File / Save As. 

 In the Save As dialogue box, navigate to: 
C:\User\Graphics\. 

 Save your file as old_image_after as a JPEG with maximum quality. 

7.8 Open old_image_before.jpg to compare it side by side with old_image_after.jpg. 
Observe the differences. 

Brush Preset picker 
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Task 8 Working with selections 

Objectives To select part of an image and discard what you don’t want to keep, or manipulate 
the selected area. 

Comments Selecting parts of an image is an essential skill in Photoshop. It is often the starting 
point for further manipulations, such as combining images together and applying 
filters/effects or making tonal adjustments to part rather than all of the image/layer 
that you are working on. 

 

Selections using the Marquee Tool 

To “frame” a selection with a clear geometrical shape, you can use either the 
Rectangular or Elliptical Marquee Tool. 

8.1 Select part of an image with the Marquee Tool: 

 Open the photograph manneken_pis.jpg in C:\User\Graphics\ and duplicate it 
(Image/Duplicate). 

 In the Toolbox, right-click on the Rectangular Marquee Tool (right) and 
select the Elliptical Marquee Tool. 

 Select an area of the image (for example the head of the statue) – it is easier to 
select from top-left to bottom-right. 

TIP: Hold down the <Shift> key as you draw your marquee, to obtain a circular or 
square shape, rather than an elliptical or rectangular shape. 

 Reposition your selection if necessary by clicking inside it and dragging to a new 
position. 

Note     You can add to selections by holding down <Shift>, or subtract from a selection by 
holding down <Alt> (alternatively you can use the Add to selection or Subtract 
from selection buttons in the Options bar – see Figure 29). 

 Experiment using the Add to selection, Subtract from selection options, 
modifying the feathering (Figure 29) and using the Rectangular Marquee Tool if 
you want. 

 

 

Figure 29 - the Marquee Tool Options bar 

Note     Feathering creates a soft edged border around the selection that blends gradually 
into the background. This technique is known as vignetting. 

8.2 Use your final selection to create a vignette image: 

 Using the Set foreground / background color tools located in the Toolbox, set the 
background colour to white or black. 

 Go to the Select menu and choose Inverse – this will inverse the selection so that 
the area outside your selection becomes selected (notice the marching ants around 
the edges of the image). 

 Press the <Delete> key to get rid of the inversed selection area. You should be left 
with a cut-out of the statue blending smoothly with a black or white background. 

New selection 
Add to selection Subtract from selection

Intersect with selection 
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 Close these images without saving. 

Selections using the Magic Wand Tool 

The Magic Wand allows selections by colour-matching. It is particularly useful when 
selecting an area containing pixels whose luminosity values are close, such as a 
blue sky for example. 

8.3 Select part of an image with the Magic Wand: 

 Open the photograph willstower.jpg in C:\User\Graphics\ and duplicate it 
(Image/Duplicate). 

 In the Toolbox, select the Magic Wand Tool.  

 In the Options bar, select the Add to Selection option (Figure 30): 

 

 

Figure 30 - the Magic Wand Tool Options bar 

 Set Tolerance to 1 and make sure Contiguous is checked. 

Note     The Tolerance option controls the range of pixels that will be included in the 
selection on either side of the pixel you click on. The Contiguous option only allows 
neighbouring areas to be selected. If it is unchecked, similar colours in unrelated 
parts of the image will also be selected. 

 Click four or five times in different parts of the blue sky area, noting the low 
tolerance. Change the tolerance to 10 and continue; you will notice that the whole 
sky soon becomes selected, outlined by a marquee (Figure 31): 

 

Figure 31 - sky selected using the Magic Wand Tool 

8.4 Add a gradient to the selection: 

 In the Toolbox, select the Gradient Tool – if it is not displayed, right-click 
on the Paint Bucket Tool and select it from the list. 

Add to selection 
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 Referring to the Tool Options bar, near the top of the screen, make sure Linear 
Gradient is selected (Figure 32): 

 

Figure 32 - the Gradient Tool Options bar 

 In the Toolbox, click the Set foreground color square to launch the Color Picker 
palette.  For optimum flexibility, ensure that the option Only Web Colors is 
unchecked. Choose a medium dark to dark colour and click OK. 

 Repeat for the Set background color square, this time choosing a lighter shade of 
the colour you selected for the foreground. 

 Place the cursor against the left-hand side edge of the blue selection and, holding 
down the left mouse button, drag the cursor in a straight line to the right edge of the 
sky and release. 

You will notice that a gradient has been applied, but only to the selected area. If you 
are unhappy with the result, you can simply drag a new gradient over the selected 
area. 

 Click <Ctrl> + D to deselect the sky – alternatively, go to Select / Deselect. 

 Close the image without saving. 

Selections using the Quick Mask mode 

Working in the Quick Mask mode, you can isolate an area by painting over it. 

8.5 Select part of an image in Quick Mask mode: 

 Open the photograph hockey.jpg in C:\User\Graphics\. 

 Select the Edit in Quick Mask Mode icon, situated below the 
foreground/background colour picker (Figure 33). 

 

Figure 33 - Standard/Quick Mask Mode icons 

 Select Brush Tool from the Toolbox. 

 Click the Brush Preset picker in the options bar (Figure 34): 

 

Figure 34 - the Brush Tool Options bar 

 The Brush Preset picker displays brushes varying in hardness and diameter. 
Choose a hard brush (indicated by a sharp circle), and set the size to 16. 

 Paint over the area you wish to select, in this case the middle hockey player (ignore 
the hockey stick). 

Note how the selected area is highlighted in semi-transparent red (Figure 35): 

Linear Gradient

Edit in Standard Mode

Edit in Quick Mask Mode

Brush Preset picker 
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Figure 35 - Quick Mask applied to middle hockey player 

 When you have finished, revert to the Edit in Standard Mode (see Figure 33) –
notice the marquee (marching ants) around the hockey player and around the edges 
of the image. 

 If necessary, tidy up the edges by returning to Edit in Quick Mask Mode, using the 
Brush Tool to add to, and the Eraser Tool to subtract from the selection. 

 Once you are happy with your selection, make sure you return to Edit in Standard 
Mode and in the Select menu, choose Inverse. 

8.6 Create a simple photo montage: 

 Open the photograph royalfort.jpg in C:\User\Graphics\. 

 Return to image hockey.jpg and, having selected the Move Tool, place 
the cursor on the highlighted hockey player and drag the selection on to 
the Royal Fort image. A new, independent layer will be created. 

 Position the hockey player where you want it on the Royal Fort image. 

 Check that the top layer containing the hockey player is highlightd in the 
Layers palette. Select the Clone Stamp Tool and in the Options bar set 
Opacity to 100%, Flow to 68%, and make sure the box labelled Sample 
All Layers is checked. 

 ‘Clone’ the flowers surrounding the hockey player, and use them to paint over the 
join in the images (see task 7.5). 

 If any traces of hockey stick are visible in the player’s hand, try using the same 
technique to remove them. 

 Save the image as success.psd in C:\User\Graphics\. 

Selections using the Lasso Tool 

The Lasso Tool is useful for selecting irregular shapes. There are three versions, 
which come under one icon in the Toolbox: 

• The default Lasso Tool is a free-hand tool useful to select very detailed 
edges and requires a good deal of practice and patience! To use it, 
hold down the left mouse button and drag a line around the desired 
area. Then release to make the selection. 



Introduction to digital imaging using Photoshop (photoshop-t1)  

38 

• The Polygonal Lasso Tool enables you to select a series of short, 
straight line segments, which makes it better to select shapes with a 
smoother edge. To use it, click the left mouse button once and move 
the mouse around the image, clicking each time you change direction. A series of 
nodes will be created to join the lines. When you arrive back at the starting point, 
click on the first node to create the selection.  

• The Magnetic Lasso Tool has as sensing area (that can be changed 
in the Options bar). When you move the cursor along the edges in a 
picture, the Magnetic Lasso can sense where that edge is and create 
a selection that follows it. It is probably the most useful of the three lasso tools. 

8.7 Make a selection with the Magnetic Lasso Tool: 

 Open the image autumnleaf.jpg in C:\User\Graphics\. 

 Select the Magnetic Lasso Tool (right-click on the Lasso Tool icon in the Toolbox 
and choose Magnetic Lasso Tool). 

 In the Options bar, set Feather to 5 px and accept the default Anti-alias, Width, 
Edge contrast and Frequency options (Figure 36): 

 

Figure 36 - Magnetic Lasso Tool Options bar 

Note     You can change the settings in the options bar for the Magnetic Lasso Tool: 
Feather (see second Note in task 8.1), Anti-alias smoothes the jagged edges of a 
selection, Width sets the radius of the area where the tool looks for the edge, Edge 
Contrast specifies how much contrast the tool should look for in finding the edge 
and Frequency specifies how often locking points are laid down. 

 Place the cursor anywhere on the edge of the main leaf, release the mouse button 
and drag the cursor around the leaf – notice how the tool automatically follows the 
edge created by colour or tone contrast. 

 If you make a mistake, just press <Delete> to undo a segment. Where there is no 
contrast for the Magnetic Lasso Tool to follow, regularly click on the edge to 
increase the frequency of locking points. 

 When you have come full circle, click the node at the starting point to make the 
selection. 

 From the main menu choose Select / Inverse and press the <Delete> key. This will 
leave the selection set against a transparent background. 

 Close the image without saving. 
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Task 9 Blending images 

Objectives To merge images together in a smooth transition. 

Comments This technique is ideal for creating seamless photomontages. 

 

Creating a new document 

9.1 Create a new file: 

 Go to File / New. In the New dialogue box, give your new image a name (eg 
firstmontage).  Set the Width to 300 pixels and Height to 100 pixels, the Color 
Mode to RGB Color and Background Contents to White (Figure 37): 

 

 

Figure 37 - New file dialogue box 

9.2 Move images to the new document: 

 Open the images library.jpg located in C:\User\Graphics\. 

 Using the Move Tool, drag the image library.jpg on to the new blank 
image. 

Notice that a new layer containing the image has been created above the white 
Background layer. 

Note     If rulers are not displayed, click View / Rulers. Right-click somewhere inside the 
ruler and set the unit of measurement to Pixels. 

9.3 Resize the image to make it smaller: 

 Ensure the top layer is selected in the Layers palette. In the Edit menu, select 
Transform / Scale. 

This will display sizing handles around the image – if you cannot see the handles, 
you can increase the canvas size by dragging its edges. 

 Hold down <Shift> to preserve the aspect ratio, and move the corner points inwards 
until you can see enough of the student in the image. 
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As you do this, you can reposition the image by placing the cursor inside the 
transform boundaries, pressing the left mouse button and dragging. Drag the image 
to the right of the canvas, leaving approximately 1/3 of the canvas uncovered and 
experiment with vertical alignment until you are happy with the position of the 
student (see Figure 38): 

 

Figure 38 - scaling down and positioning the library image 

 Click <Enter> to commit the change – at this point, you can reposition the image if 
you wish. 

Note     If the image keeps snapping to edges of the canvas, turn the Snap feature off by 
selecting View / Snap and making sure the Snap option is unchecked. Repeat this 
process to reset it if required. 

9.4 Repeat steps 9.1 to 9.3 with the image computer.jpg, aligning it left, overlapping 
the library image. It should cover just over ½ the canvas (see Figure 39): 

 

Figure 39 - two overlapping layers 

Note     It is important that the images overlap sufficiently for the blending effect to work. 

Blending the images 

9.5 Blend the images as follows: 

 Make a note of the computer image’s right edge on the horizontal ruler (around 150 
to 170 pixels), and in the Layers palette, make sure Layer 2 (the computer image) 
is selected. 

 Then in the menu bar at the top, go to Layer / Layer Mask / Hide All to add a layer 
mask. 

You should now see the Layer Mask as illustrated in Figure 40: 
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Figure 40 - Layer Mask applied to top layer 

This renders the layer invisible, indicated by a black thumbnail in the layers palette. 

Various tools can be used to ‘paint the layer back’. In this case, the 
Gradient Tool is used to achieve a smooth transition from transparent to 
fully visible. 

 Having made sure the foreground colour is set to black, select the 
Gradient Tool – if you can’t see it, right-click on the Paint Bucket Tool 
and select it. 

 Place the cursor just inside the right-hand edge of the computer image (refer to the 
note you made earlier), roughly in the middle vertically. Click, hold down the left 
mouse button and drag the mouse to the left, in a straight, horizontal line, stopping 
just on the left edge of the library image, and release. 

You will notice the computer image gradually appearing. The image becomes 100% 
visible at the point at which the mouse is released. You will notice that the black 
thumbnail now displays the applied gradient. 

  

Figure 41 - Layer Mask after the Gradient Tool has been applied to it 

If you are unhappy with your gradient, simply click and drag the mouse again. The 
shorter the drag, the less gradual the transition between invisible and opaque. 

Your blended image should look something like Figure 42: 

 

Figure 42 - Layers gradually blended together 
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9.6 Merge the two layers: 

 In the Layers palette, select one of the image layers, press <Shift> and select the 
other image layer. 

 With the two image layers selected, click on the Link layers icon at the bottom of 
the Layers palette (Figure 43): 

 

Figure 43 - linking the two image layers 

Notice the link symbol is now displayed to the right of each image layer, indicating 
that these layers are linked. 

Note     Linking layers is particularly useful when you want to apply the same changes (eg 
repositioning, styles, etc.) to several layers. 

 In the Layers menu, select Merge Layers. As a result, the two linked layers will 
become one (Figure 44): 

 

Figure 44 - merged linked image layers 

 Save the image as firstmontage.psd in C:\User\Graphics\. 

Link layers icon 
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Task 10 Working with text layers 

Objectives To add and manipulate text layers. 

Comments You can create type (text) anywhere in an image in Photoshop. When you create 
type, a new type layer is added to the Layers palette. You can then manipulate it 
like any other object (image, shape, selection, etc), and the text itself will remain 
editable. 

 

Preparing the text background image 

10.1 In order to work as a background for text, the photo needs to be less opaque. A 
background colour needs to be set, to bleed through as the image transparency 
increases: 

 In the Toolbox, click on the Set foreground color square and choose a fairly dark 
colour. 

In the Layers palette: 

 Select the Background layer (currently white) and use the Paint Bucket Tool to 
flood fill the whole canvas. 

 Next, select Layer 2 (i.e. the photo montage) and click the Opacity settings triangle 
at the top right of the Layers palette (Figure 45): 

 

Figure 45 - changing the opacity level of a layer 

Moving the slider to the left will gradually reveal the background layer. Set opacity 
between 30% and 50%. 

You should now have a suitable background for your text. 

Adding text 

10.2 Add some text: 

 In the Toolbox, select Type Tool and click somewhere in the image. Note 
that a new layer appears in the Layers palette. 

 In the Type Tool Option bar (Figure 46) click on the Set the text color option and 
pick a light colour for your text: 

 

Figure 46 - the Type Tool Options bar 

 Choose a font, style, size and anti-aliasing method from the font options (for 
example Arial, 18pt, Bold, Sharp). 

Note     Anti-aliasing smoothes jagged edges by adding shading or colours. 

Set layer opacity 

Set the text color 

Toggle the Character and Paragraph palettes

Create warped text
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Note     Working at different image resolutions will result in variations in apparent text size.  
For example text will appear much smaller in a 300dpi image than in a 72dpi (typical 
screen display resolution) image. 

 Type Information Services, press <Enter> to start a new line and type Open Day. 

10.3 Edit and position the text: 

 Make sure the Type Tool is selected in the Toolbox and highlight the second line of 
text. 

 Using the Set the text color picker, choose a new colour and, when you are happy 
with your choice, deselect the text by clicking outside it. 

 Use the Move Tool to position your text on the canvas. 

Enhancing the text 

Several effects can be added to the text. A subtle drop-shadow can add definition 
when text is set over a slightly ‘busy’ background. 

10.4 Add a drop-shadow: 

 In the Layers palette, make sure the Type layer is selected and click the Add a 
layer style icon at the bottom (Figure 47): 

 

Figure 47 - the Type layer in the Layers palette 

 From the pop-up menu, select Drop Shadow. This will launch the drop shadow 
options palette, adding a default shadow to the text. 

 Experiment with the Structure options (Blend Mode, Colour, Opacity, Angle, 
Distance, Spread and Size) and click the OK button when you are happy. 

Note     Layer styles are applied to every object within a layer. 

Your image should now be similar to Figure 48: 

 

Figure 48 - banner comprising text over background image 

Add a layer style icon 
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 When you are happy with your image, save as firstmontage.psd in 
C:\User\Graphics\. By saving in this format, text will remain editable. 

10.5 Save a copy for the Web (see Task 6.1). As the image includes photographs, the file 
should be saved as a JPEG. 

Note     Further text editing is possible via the Paragraph and Character palettes (open by 
clicking the Toggle the Character and Paragraph palettes icon on the Type Tool 
Options bar. By default, the palettes are bundled together. Toggle between them by 
clicking the labelled tabs. The Paragraph palette enables line spacing, alignment 
and so on to be set. The Character palette provides a shortcut to several formatting 
elements also found elsewhere (anti-aliasing, font colour, font size etc.) 
 
You can also warp text in many different ways by using the Create warped text 
option. Feel free to try these out. 

 



Introduction to digital imaging using Photoshop (photoshop-t1)  

46 

Appendix A Resolution and image size for printing 
    Print size at: 

Pixel size Megapixels RGB size 
(MB) 

CMYK size 
(MB) 

150 ppi 300 ppi 

1600 x 1200 2 6 7.5 11 x 8 inch 
(28 x 20 cm) 

5.5 x 4 inch 
(14 x 10 cm) 

2400 x 1800 4.3 12.5 16.5 16 x 12 inch 
(40 x 30 cm) 

8 x 6 inch 
(20 x 15 cm) 

3000 x 2000 6 17.5 23.5 20 x 13 inch 
(51 x 33 cm) 

10 x 6.5 inch 
(25 x 16.5 cm) 

3500 x 2500 8.75 25 33.5 23 x 17 inch 
(58.5 x 43 cm) 

11.5 x 8.5 inch 
(29 x 21.5 cm) 

Table 1 – Comparison of pixel resolution, megapixels, megabyte file size and print output 
dimensions at different resolutions in inches (and centimetres) 

 

Output use Screen ruling x 1.5 Standard quality 
output resolution 

x 2 High quality 
output resolution 

Newspaper 65 – 100 lpi 97 – 150 ppi 130 – 200 ppi 

Books 120 – 150 lpi 160 – 225 ppi 240 – 300 ppi 

Colour magazine 150 – 175 lpi 225 – 262 ppi 300 – 350 ppi 

Art book/magazine 175 – 250 lpi 262 – 375 ppi 300 – 500 ppi 

Photo quality inkjet printer 150 – 300 lpi 225 – 450 ppi 300 – 600 ppi 

Table 2 – Rule of thumb screen resolutions for common print devices at lpi x 1.5 and x 2 
quality factors 

 

Example 

Say you want to print a high quality A4 photograph on an inkjet printer: 

A4 size = Width 8.268 x Length 11.693 inches (21 x 29.7 cm) 

Printer resolution = 200 lpi 

Quality factor = x 1.5 

Print length x Printer resolution x Quality factor = number of pixels required in length 

11.693 x 200 x 1.5 ≈ 3500 pixels in length 

Print width x Printer resolution x Quality factor = number of pixels required in width 

8.268 x 200 x 1.5 ≈ 2480 pixels in width 
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Appendix B Further resources 

General information 

TASI (Technical Advisory Service for Images) – http://www.tasi.ac.uk 

The advice section is highly informative. Any questions that you may have regarding 
all stages of image digitisation will be answered. The sub-section entitled ‘Creating 
Digital Images’ is particularly relevant to this course. 

Internet for Digital Photography – http://www.vts.rdn.ac.uk/acl/tutorial/digiphoto 

Scanning 

Apart from the TASI website, you may find the following site very useful for all 
scanning issues: 

A few scanning tips, by Wayne Fulton – http://www.scantips.com 

Photoshop tutorials 

These tutorials cover most things you can do in Photoshop, including some useful 
tutorials on image enhancement and restoration: 

Adobe’s Photoshop tutorials – http://www.adobe.com/products/tips/photoshop.html 

Janee’s Photoshop tutorials – http://myjanee.home.insightbb.com/tutorials.htm 

‘Computer Arts’ Photoshop tutorials – http://www.computerarts.co.uk/tutorials/2d/ 

 


